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Excel Worksheets Skills

First \ Last Split Bar \
] W < W High School -~ HR Data _ Bowlng . Employees  Taxes ( #J _ o
Previous Next \< Insert Worksheet
Name Worksheets
1. Double click on the worksheet tab.
2. Type a new name for the sheet and press Enter key.
Add a Worksheet
Click on the Insert Worksheet Button ‘Employees  Taxes m
g
Right-Click on a Sheet Tab
Insert...
Employees . Taxes . ¥J Delete
Rename
Insert, Delete, Tab Color, Hide & Unhide Sheets, Select all Sheets Move or Copy...
Ll View Code
| Protect Sheet...
Ibfoler ¥
Hide
Unhide...
Select All Sheets

Copy Worksheets

1. Right-Click on the sheet tab and select Move or Copy.

[¥] Create a copy

2. In the lower left corner of the dialog box click on Create a copy

OR ...

Place the mouse pointer on the Tab
Hold down on the Ctrl key and drag the sheet to a new location.
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Moving and Copying Sheets to Another Excel Book

1. Have both Excel Books open (have the two Excel files open).

fove or Copy
2. Select the worksheet that you want to move or copy. 'T":Ezjffemd e
v . {Rosewood Data.xex
3. On the Home tab, in the Cells group, click Format, and then e

under Organize Sheets, click Move or Copy Sheet.

(Or Right-Click on a sheet tab, then choose Move or Copy)

| {move to end)
4. Fill in the dialog box indicating where you want the sheet

moved or copied.

Check the box if you want to ' @g&atﬁ a copy
copy the worksheet ‘

Grouping Sheets

When sheets are grouped, you can quickly enter, edit, and copy data for multiple sheets.
you make on the active sheet are also made on all the other grouped sheets.

1. Click on the first sheet tab to include in the group.
2. Shift + click on the last sheet tab to include in the group.

(Ctrl + click on individual sheets to include or exclude).

Ungrouping Sheets

Right-click on a sheet tab and select Ungroup from the shortcut menu.

Changes
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Viewing Options for Large Worksheets

Freezing Panes

Use this option to prevent headings from scrolling off the page when you scroll down or across.

1. Position the cell pointer. (In our example cell D2).

2. On the View tab, in the Window group, click the A B C BN E
Freeze Panes button and choose Freeze Panes 1 School  LastName First Name|Emp# Gender
2 ComoElem Doyle Lany (1932w
3. To unfreeze the panes: On the View tab, in the 3 DistOfice  Young Fran 1011 F
Window group, click the Freeze Panes button and 4 ComoElem Cooper Linda 1280 F
choose Unfreeze Panes 5 DistOffice Bankler  Powena 1908 F

Split Pane / Workbook Screen

1. Place the mouse pointer on Point the split box at the top of the vertical
scroll bar or at the right end of the horizontal scroll bar.

2. When the pointer changes to a split pointer %or ¥, drag the split box down or to the left to
the position that you want.

3. To remove the split, double-click any part of the split bar that divides the worksheet.

Note: You cannot freeze panes and use split at the same time.
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Conditional Formatting

Use this feature to change the formatting appearance of the data based on a condition.

1. Select a range of cells containing numeric values you want to place a conditional format.

2. On the Home tab, in the Styles group, click on the Conditional Formatting button

3. Float the mouse pointer down to Color Scales or Data Bars and then float across (don’t click)

to the various choices and notice how the appearance of your data changes.

Format cells that match specific criteria.

For example, display test scores greater than 90 in a different color.

] s
1. Select a range of cells — then click on the Home tab

[ | Konsess
2. Click on the Conditional Formatting button and click New Rule ‘

3. Choose “Format only cells that contain

4. Enter in the Rule / Criteria

5. Click on the Format Button

i
ﬂ;’ Mew Rule
g _‘j« Clear Rules

; _;—J Manage Rules...

Conditianal
Farmatting =

Select 3 Rule Typs:

» Formst all cells based on their values

» Format only celis that contain

Edit the Rule Deseription:

‘ Format only cells with:

{ | Cell Value

{v] greater thanorequalto [+] 50
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Excel 2010 Table Features

An Excel 2010 Table (previously known as list or a database) is a continuous set of rows and

columns. It has no blank rows or no blank columns..

The rows & columns must be continuous--you cannot have a blank row or column.

To use any of the Excel Database feature you need to first single-click in the Database

Quick Sorting (one level)

1. Click anywhere in a column you want sorted

2. On the Data tab under the Sort and Filter group click on the AZ or ZA buttons

Filter .
2 sdvanced

Sort & Filter

Multiple Level Sorting

1. Click anywhere in a column you want sorted

2. On the Data tab under the Sort and Filter group click on the Sort button

M=
Cye

[P
o1
-~

3. Click on the Add level button to select another sort level ; %4 Add Level £
Sort gll=
"“glédd Level H 77( Lelete Level H <3 Copy Level ‘} ' t ,1 Options... E (¥ My data has headers
| Column 7 soton Order i
1 Sortby  [schel [F] |values [] w2z =] |
{Thenby [|ast Mame [v] values v] Atz (]|
]
ok || cancel |

i
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Filtering

1. Single-click anywhrere in the Table =
f
2. On the Data tab under the Sort and Filter group click on the Filter button to
activate the drop down filtering buttons Filter

3. Choose a value to filter

et i B il sl Do el illaog :' s T
School i"|Lastﬂgn‘i"lFirstNaf{'gEm(' Gender ¥ | Deparinfe| ¥ TUp dowil

1 L

2 DistOffice McGuie  Elen 1932 F Business = Filtering buttons
3 DistQffice  Gartan Hazel 1011 F Business

4 ComoElem Coopsr Linda 1290 F Admin,

Note : When a field has been filtered, the drop down arrow changes to a filter icon "

To remove all filters from all columns: (you want to show all records)

On the Data tab under the Sort and Filter group click on the Clear button & Clear

To remove the Filter feature (remove the drop down arrows) 7
On the Data tab under the Sort and Filter group click on the Filter button J

Fiiter

Text, Number or Date Filters

You can precisely target values for Numbers, Text or Dates in a column SortateZ
SontZto A
1. Click on the drop down filter arrow for a colum Sort by Color

2. Point to either Text, Number or Date Filters and then click one of the

commands (. = Teut Fitters
[ (Select All)
[ Accountant
Enter criteria in the Search box B e

A Search box displays in the AutoFilter menu. You can type characters on which you want to
filter in this box for specific values.
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Data Subtotals

AR a7 Y G H I J
1 School Fee Paid Balance Salary

(+| 42 ComoElem Total $5746.00 $1,22885 $45617.15 $1.678.233

'+ B2 Dist Office Total $253832  $43363 $209375  $956.065

{+| 116 Kennedy Total  $7.756.43 $1617.93 $613350 $2.027.220

[+ 161 Lincoln HS Total $5.78235 $1.47085 $431148 $36595189

= 162 Grand Tatal $21,82315  $4757.28 $17.085.88 $3.256.712
163

In our example, each time the value for the School changes we want to Sum (add) the values for
the fields: Fee, Paid, Balance and Salary

1. Click in the Excel Table.
2. Sort the Table by the field you want to subtotal.
(In our example we first need to sort the list by school)
[ 2

3. On the Data tab in the Outline group click on the Subtotal button. & :__l

4. Complete the window as illustrated below: Subtatal
Subtetal % )&=
TR — Hide/show detail buttons
S“j:‘ - B 1 = Only Grand Total
li"jm L ] 2 = Only Sub Summaries
Agdsubtomltes - 3 = All detail

i 4
[¥] Replace current subtotals l
(] Page break between grougs 2
{1 Summary below: data =

[ Removeas | [ o | [ conel |

Remove the Subtotals

1. Single-Click in the Excel Table
2. On the Data tab in the Outline group click on the Subtotal button
3. Click on the Remove All button.

E;n;ve All ' ,
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Copy Sub-totals in Excel 2010

Copy only the Excel subtotals to another Worksheet

1) Select the sub-totals that you want to copy

I D H | J K
Last Name |Building Salary Fee Paid Balance
Dist Office Total $873,065 $2538.38 $439.63
Glen Elem Tofal $1,649833 $561450 $1,202.60
Kennedy Tofal $2,027220 $7,796.43 $1,617.93
Lincoln HS Total $1,712270 $5882.35 $1,470.88
Grand Tofal $6,262,388 $21,79165 $4,731.03

2) On the “Home” tab of the Ribbon, look for the “Editing” group — usually it is the last one, all
the way over at the right hand side of the Ribbon.

3) Click on “Find & Select”

k Find &
r Select~

4) On the little menu that appears, click “Go To Special”

5) In the box that appears, make sure you select “Visible
Cells Only” in the right hand column

6) Click OK

7) Copy using the Excel menu (or Ctrl + C) and then paste your sub-totals in your new

Worksheet

Go To Special [P et
Select
Comments Row differences
Constants _+ Column differences
Formulas " Precedents

Blanks
Current region

P & Dok

e
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Create an Excel Table

Use this command to define a block of data as an Excel 2010 Table

1. Select the range of cells that you want to include in the Table. The selection contains no blank

columns or blank rows)

2. On the Insert tab, in the Tables group, click on the Table button.

=

Table

3. If the selected range contains column headers, select the “My table has

headers” check box.

Table Tools : Design Tab & Totals Row

Create Table ?.

2

Where is the data for your table?
=$A51:6D%4

{V] My table has headers

£

When using this method of defining a table a new Tab will display. The Table Tools will display

adding a Design tab.

Use this to include a Total Row at the bottom of the table or to apply various Designs for the

table

Check the “Total Row” box to see summary data at the end of your table

-

LR } aad Zerbackie Beuy Rosemaunt

12 95 F
\ [¢] HeaderRow [ | First Co!u‘ ‘M Emmerr Anoka
7] TotalRaw [ Last Cot] BE -—

7! Banded Rows [_| Banded C|
Tabﬁa <* :Jt: ns |

Choose various Table Styles |ZZZZ:Z =S=== ZZ=SZ=

Remove the Table Feature

1. Click anywhere in the table.

2. On the Design tab, in the Tools group, click Convert to Range.

Or Right Click in the table and choose Table — Convert to Range
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Excel Database Functions
Excel provides 12 functions that you can use to analyze the information in your database. All the
database functions start with the letter “D” (DAVERAGE, DMAX, DMIN, DSUM, etc.) and
require three pieces of information:
e Database the range of cells that make up the database.

* Field indicates which field or column that you want to analyze.

e C(Criteria the range of cells that contains the criteria that you will enter.

Data Average Function (DAVERAGE)

This function will average the values of a field that match a variety of criteria.

DAVERAGE(database-range, field, criteria)

The formula for our example will be entered in cell D10
=DAVERAGE(B13:5167,J13,G10:J11)

-
//"
¥ [Field
Average $40,291 Schaol Department Peosition Gender =
///
Y
Emp#t School Last Name Fust Name Gender Position Department Burth Date Salary Start Date Sick
2858 Coma Airre Dava i Teacher Enginesring 1041171961 27833 Q41271887 1800
2368  Como Andersen Tam i Teacher St WWAAMI $858322 4fEn982 1.50
1768  Como Bragne Mealia F Murse Health 3/30/1561 $36.940 942041987 a0
2768 Coma Brewne Tam bt Teacher Bus ED B#26/1362 $28550 3/6/1985 200
1311 Coma Cane HES E Clerk: Business §/31/1960 $25893  ¥/7A1988 075
1331 Come Cash Many F Teacher Business 5/341349 $47.853 641241989 1.00
1724 Coma Chu Steven td Cur. Admin BusED $41451956 $35.786  12/26/1934 176
1230 Coma Caaper Linda F &drin Sssist.  Business GATA%RS $41.539 0 241441939 4.00
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Concatenate Function

| e3 - A =CONCATENATE(A3," " B3)
Concatenate joins several text items into one text | A B EEHURRS D | E
item. For instance, if first name and last name are | ! First  Last Full
in separate columns, they can be joined together _§_jLittl = Richard e ered
. 1]
into one column. 4 Mick Jagger

Click where you want the joined text strings (C3)
2. Click the Insert Function button and start the Concatenate function (Text category)

In our example, the first argument (Text 1)

should be cell A3 )
unction Arguments
4. The second argument (Text 2) Type a quotation CONCATENATE -
mark, a space, and another quotation " " b :“3
Texk2 ("
Excel will place a space between the first and Text3 [54]

last names. | Text |
5. The third argument (Text 3) should be cell B3 '
Click OK.

Use the Fill Handle to copy the formula down the column for other names.

If you delete the first and last name columns, you will lose the text, as you did in the previous
example when we used the Proper function. Use the Copy and Paste Values procedure to
convert the full names to text values.

. . . Paste Special
Edit Copy - Edit Paste Special - Values
A e
@ au O validation
_) Formulas ) All except borders
7 Values () Column Widths
") Formats ) Formulas and number formats
) Comments () Values and number formats
Op:
@ None 7 Multiply
7) Add O Divide
") Subtract
{1 Skip blanks | Transpose
e (G ()
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Numbers Stored as text

Excel Error Checking Options button 3> w

The whole sheet

1 Click on the first error symbol on the sheet to display the yellow icon
2. Ctrl —a to select the entire sheet

3 Click on the drop down arrow of the Excel Error Checking Options button

Owlos

Sl B D Lot B
e g

- : e e
4 Choose Convert to number 2 0025512158 @ -014 37
= L ?35?8 Number Stored as Text
4 |0012172679
:éi_[m38885553 Convert to Number
| 6 |0067902818 o bt o N
=z <L0030559548 Ignore Error
| 8 [0066743070 Edit in Earruls B
0091151651 e
2 v - Error Checking Options...
1N (N2ATT1982

One column at a time

1 Click in the first value of a column, the Excel Error Checking Options button displays
2 Ctrl-Shift press the Down Arrow key to select the whole column
3 Scroll back up to the top of the column

3 Click on the drop-down arrow of the Excel Error Checking Options button 4!; ,I

4 Choose: Convert to Number — ;‘»\

Turn off the symbo:l

Options - Formulas - Error Checking - Enable background error checking
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